IBM InfoSphere DataStage and QualityStage
Version 9 Release 1

Guide to Integrating Streams Applications
Before using this information and the product that it supports, read the information in "Notices and trademarks" on page 27.
# Contents

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Integrating InfoSphere Streams Applications (InfoSphere Streams</strong></td>
<td></td>
</tr>
<tr>
<td><strong>connector)</strong></td>
<td>1</td>
</tr>
<tr>
<td>Importing metadata from InfoSphere Streams applications by using the</td>
<td>1</td>
</tr>
<tr>
<td>InfoSphere Metadata Asset Manager</td>
<td></td>
</tr>
<tr>
<td>Managing InfoSphere Streams metadata by using the istool command</td>
<td>1</td>
</tr>
<tr>
<td>Designing jobs (InfoSphere Streams connector)</td>
<td>1</td>
</tr>
<tr>
<td>Defining an InfoSphere Streams connector job</td>
<td>2</td>
</tr>
<tr>
<td>Configuring the connection properties to connect to InfoSphere</td>
<td>3</td>
</tr>
<tr>
<td>Streams name server (InfoSphere Streams connector)</td>
<td></td>
</tr>
<tr>
<td>Receiving data (InfoSphere Streams connector)</td>
<td>5</td>
</tr>
<tr>
<td>Sending data (InfoSphere Streams connector)</td>
<td>7</td>
</tr>
<tr>
<td>Runtime column validations (InfoSphere Streams connector)</td>
<td>9</td>
</tr>
<tr>
<td>Data type conversions (InfoSphere Streams connector)</td>
<td>9</td>
</tr>
<tr>
<td>Compiling and running InfoSphere Streams connector jobs</td>
<td>13</td>
</tr>
<tr>
<td>Troubleshooting (InfoSphere Streams connector)</td>
<td>14</td>
</tr>
<tr>
<td><strong>Appendix A. Product accessibility</strong></td>
<td>17</td>
</tr>
<tr>
<td><strong>Appendix B. Reading command-line syntax</strong></td>
<td>19</td>
</tr>
<tr>
<td><strong>Appendix C. How to read syntax diagrams</strong></td>
<td>21</td>
</tr>
<tr>
<td><strong>Appendix D. Contacting IBM</strong></td>
<td>23</td>
</tr>
<tr>
<td><strong>Appendix E. Accessing and providing feedback on the product</strong></td>
<td>25</td>
</tr>
<tr>
<td><strong>documentation</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Notices and trademarks</strong></td>
<td>27</td>
</tr>
<tr>
<td><strong>Index</strong></td>
<td>31</td>
</tr>
</tbody>
</table>
Integrating InfoSphere Streams Applications (InfoSphere Streams connector)

The InfoSphere Streams connector enables integration between InfoSphere Streams and InfoSphere DataStage. You can use the InfoSphere Streams connector to send data from an InfoSphere DataStage job to an InfoSphere Streams job, and also to send data from an InfoSphere Streams job to an InfoSphere DataStage job.

By sending data to InfoSphere Streams from the InfoSphere DataStage jobs, InfoSphere Streams can perform near real-time analytic processing (RTAP) in parallel to the data being loaded into a warehouse by InfoSphere DataStage. Alternatively, when sending data from InfoSphere Streams to InfoSphere DataStage, the InfoSphere Streams job performs RTAP processing, and then forwards the data to InfoSphere DataStage to enrich, transform, and store the details for archival and lineage purposes.

Importing metadata from InfoSphere Streams applications by using the InfoSphere Metadata Asset Manager

You can import endpoints into the metadata repository of InfoSphere Information Server. You can use the endpoints in InfoSphere DataStage and QualityStage jobs.

You can import endpoints from multiple applications. The imported endpoints contain tuples and tuple attributes. Tuples can contain multiple tuple attributes. Tuple attributes are the equivalent of InfoSphere DataStage column definitions. A tuple attribute can also be a tuple, in which case it can contain other tuple attributes. Application name and application scope are properties of the imported endpoint. Not all endpoints have an application scope.

For details on how to import metadata by using InfoSphere Metadata Asset Manager, see the IBM Information Center or in the IBM InfoSphere Information Server Guide to Managing Common Metadata.

Managing InfoSphere Streams metadata by using the istool command

You can move endpoints from one InfoSphere Information Server environment to another by using the istool command line. For example, you can move endpoints from a development environment to a test or production environment.

For more information on the istool command line and how to migrate the InfoSphere Streams assets see the IBM Information Center or in the IBM InfoSphere Information Server Administration Guide.

Designing jobs (InfoSphere Streams connector)

You can use the Streams connector to develop jobs that receive and send data.

Procedure

2. “Configuring the connection properties to connect to InfoSphere Streams name server (InfoSphere Streams connector)” on page 3.
3. To set up the Streams connector as a source to receive data:
   a. Configure Streams connector as a source
   b. Set up column definitions
   c. Define the properties for receiving data
4. To set up the Streams connector as a target to send data:
   a. Configure the Java Stage as a target
   b. Set up column definitions
   c. Define the properties for sending data
5. Compile and run the job

Defining an InfoSphere Streams connector job

Use the InfoSphere® DataStage® and QualityStage® Designer client to define a job by using the InfoSphere Streams connector.

**Procedure**

1. From the Designer client, select File > New from the menu.
2. In the New window, select the Sequential Job or Server Job icon, and click OK.
3. In the Designer client from the Palette menu, select the Real time category.
4. Locate Streams Connector in the list of available databases.
5. Drag the Streams Connector stage icon to the job design canvas.
6. Enter or modify the following attributes:
   - **Name of the Streams Connector stage or link**: Modify the default name of the connector or the link. You can enter up to 255 characters. Alternatively, you can modify the name of the stage or link in the job design canvas.
   - **Description**: Enter an optional description of the stage or link.
7. Optional: Click Configure... to define additional configuration properties and select the endpoint metadata. For details see, “Selecting endpoint metadata in the InfoSphere Streams connector stage GUI.”
8. Click Save.

What to do next

Define properties to use InfoSphere Streams connector as a source.

**Selecting endpoint metadata in the InfoSphere Streams connector stage GUI**

When designing a job in InfoSphere Streams connector, for additional configuration, Streams connector provides a wizard that contains a set of configuration panels.

**Procedure**

1. On the job design canvas, double-click the Streams Connector icon.
2. Click the Configure button for defining the additional configuration properties. The InfoSphere Streams endpoint selection window is displayed.
3. In the InfoSphere Streams endpoint selection window, select an endpoint and click OK.
   - If the InfoSphere Streams connector is defined as a source with a single output link, any columns currently defined for the link are deleted and replaced by the columns defined by the tuple definition.
If the InfoSphere Streams connector is defined as a target with a single input link, the columns defined by the tuple are added to the columns of the input link.

**Configuring the connection properties to connect to InfoSphere Streams name server (InfoSphere Streams connector)**

The InfoSphere Streams connector attempts to access the name server when the InfoSphere DataStage job starts. The InfoSphere Streams connector uses the InfoSphere Streams Web Server (SWS) name server service to request the Streams Application connection information.

The InfoSphere Streams connector looks up the host and the port, to connect to the Streams application, from the Streams name service. The InfoSphere Streams connector must be configured to use the Streams name server to resolve the endpoint host and port. Once the host and the port of the endpoint have been established, then the InfoSphere Streams connector attempts to make a client connection to the InfoSphere Streams job.

You need to define the following connection properties as input arguments for the name server service lookup:

- Endpoint name
- Application scope
- Name server host
- Name server port
- Username
- Password
- Keystore certificate

The InfoSphere Streams name server returns the following two values as a result of the successful lookup:

- Application host name
- Application port number

The InfoSphere Streams connector uses the **Application host name** and **Application port number** values to connect to the InfoSphere Streams Application DSSource or DSSink operators.

**Authenticating the InfoSphere Streams name server (InfoSphere Streams connector)**

You need to set up the InfoSphere Streams connector to authenticate against the InfoSphere Streams name server. The InfoSphere Streams connector uses the InfoSphere Streams name server to lookup the host and port that it wants to connect to. Use the connection properties of the InfoSphere Streams connector to define the connection to the name server.

The InfoSphere Streams name server host is the host name of the system that runs the InfoSphere Streams SWS name server service. If you do not know the name server host name, consult your InfoSphere Streams administrator to help you identify the system that runs the InfoSphere Streams SWS name server service.

For more information about the InfoSphere Streams concepts and commands, see the *InfoSphere Streams Installation and Administration guide*. 
To identify the InfoSphere Streams name server port use the `geturl streamtool` command. Execute the `geturl` command on the system that hosts the Streams SWS name server service, for example:
```
streamtool geturl -i myStreamsInstance
```

Communication with the name server is via HTTPS which requires that the self-signed certificate of the Streams server is available in a keystore file on the player node that is hosting the Streams connector stage.

The server keystore file `ibmjsse2.jks` can be found in the home directory of the Streams instance owner directory:
```
<Streams Instance Owner Home Directory>/instances/[instanceid]/sws/security/keystore
```

You can export the keystore certificate from the InfoSphere Streams name server and import into a new or existing keystore file stored on the player node that is hosting the InfoSphere Streams connector stage. If the server certificate is replaced by a new one, the following procedures and steps need to be repeated to update the keystore on the client side.

### Exporting the Streams Certificate

To export the Streams Certificate, use the `keytool` command that is provided in the jre directory of the InfoSphere Streams server installation as follows:
```
<Streams>/jre/bin/keytool -keystore ~/.streams/instances/[instanceid]/sws/security/keystore/ibmjsse2.jts -export -alias lwiks -file <certificate-file>
```

The alias is always `lwiks`; which is defined by InfoSphere Streams and cannot be configured. This command exports the certificate that is associated with the alias `lwiks` to the specified certificate file. The command prompts for the password of the truststore file. By default, the password is `ibmpassword`.

### Importing the Streams Certificate

To import the Streams Certificate, use the `keytool` command that is provided under the `ASBNode` or `ASBServer` directories of the InfoSphere DataStage engine install.

Before running the command, copy the certificate file exported from InfoSphere Streams to the InfoSphere DataStage engine server. If the keystore file exists, then you are prompted to enter the password for the file. If the file does not exist, then you are prompted to create a password for the file. Click Yes if asked whether to trust the certificate.

Use the command as follows:
```
<InformationServer>/ASBNode/apps/jre/bin/keytool -import -alias lwiks -file <certificate-file> -keystore <keystore-file>
```

### Client Authentication (InfoSphere Streams connector)

To provide additional security, you can configure client authentication to restrict Streams Web Server (SWS) connections to specified clients only.

By default, client authentication is not enabled for the InfoSphere Streams Console. If you enable and configure client authentication, the InfoSphere Streams Console allows HTTPS connections from trusted clients only. Otherwise, any user who is
authorized to use the InfoSphere Streams instance and has access to the server and port that the InfoSphere Streams Console is running on, can log in using a valid user ID and password.

Receiving data (InfoSphere Streams connector)

To receive data from a Streams application by using the InfoSphere Streams connector, you need to configure the InfoSphere Streams connector as a data source. The InfoSphere Streams connector connects to the Streams application endpoint that is defined by the Streams application DSSink operator, and receives data from that operator.

The following figure shows an example of using the InfoSphere Streams connector to receive data. In this case, the InfoSphere Streams connector Streams_Connector_0 receives data from the InfoSphere Streams server and then the sequential file stage writes it to the file Sequential_File_1. When you configure the InfoSphere Streams connector to receive data, you create only one output link, DSLink2, which is shown in the figure below transferring rows from Streams_Connector_0 to Sequential_File_1.

![Example of receiving data](image)

Configuring InfoSphere Streams connector as a source

You can configure the InfoSphere Streams connector to process data as a source for 1 output link.

**Procedure**

1. On the job design canvas, double-click the Streams Connector icon.
2. In the top left corner of the stage editor, select the output link that you want to edit. By editing the output link you are setting up Streams Connector to be the source.
3. Specify the Link and Description properties.
4. Optional: Click Configure to configure additional properties. Select one endpoint from the displayed list of application names together with endpoint names that are imported into the repository. Click OK. The tuple definition of the endpoint is loaded into the list of columns on the output link and the columns currently defined for the link are deleted and replaced by the columns defined by the tuple definition.
5. Specify additional details in the **Properties** tab, the **Columns** tab, and the **Advanced** tab.
6. Click **OK** to save the connection settings.

**Setting up column definitions (InfoSphere Streams connector)**
You can set up column definitions for a link and also customize the columns grid, save column definitions, and load predefined column definitions from the repository.

**Procedure**
1. On the job design canvas, double-click the **Streams Connector** icon.
2. Select the **Output** link tab.
3. On the **Columns** tab, modify the columns grid to specify the metadata that you want to define.
   a. Right-click within the grid, and select **Properties** from the menu.
   b. In the Grid properties window, select the properties that you want to display and the order that you want them to be displayed. Then, click **OK**.
4. Enter column definitions for the table by using one of the following methods:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Method 1: Work in column grid directly  | 1. In the **Column name** column, double-click inside the appropriate cell and type a column name.  
   2. For each cell in the row, double-click inside the cell and select the options that you want.  
   3. In the **Description** column, double-click inside the appropriate cell and type a description. |
| Method 2: Work in a separate window      | 1. Right-click within the grid, and select **Edit row** from the menu.  
   2. In the Edit column metadata window, enter the column metadata. |

5. To share metadata between several columns, right-click the column and select **Propagate values**. In the Propagate column values window, select the properties that you want the selected columns to share and click **OK**.
6. To save the column definitions as a table definition in the repository, click **Save** and specify the name and location for the table definition.
7. To load column definitions from the repository, click **Load** and select the table definition and columns that you want to load.

**Defining properties for receiving data (InfoSphere Streams connector)**
You must configure how the InfoSphere Streams connector operates in a job when receiving data by defining the usage properties.

**Before you begin**
You must configure a connection (as a source) for the InfoSphere Streams connector.
**Procedure**

1. On the job design canvas, double-click the Streams Connector icon.
2. Click the Properties tab.
3. On the Properties tab define the properties in the Usage section to specify how the connector operates in a job.
4. Click OK to save your changes.

**Sending data (InfoSphere Streams connector)**

To send data to a Streams application by using the InfoSphere Streams connector, you need to configure the InfoSphere Streams connector to process data as a target. The InfoSphere Streams connector connects to the external Streams application endpoint that is defined by the Streams DSource operator and sends data to that operator.

The following figure shows an example of using the InfoSphere Streams connector to send data. In this case, the sequential file reads data from the file `Sequential_File_1` and then the InfoSphere Streams connector sends data to the Streams application endpoint.

![Figure 2. Example of sending data](image)

**Configuring InfoSphere Streams connector as a target**

You can configure the InfoSphere Streams connector to process data as a target for 1 input link.

**Procedure**

1. On the job design canvas, double-click the Streams Connector icon.
2. In the stage editor, select the input link that you want to edit. By editing the input link you are setting up Streams connector to be the target.
3. Specify the Link and Description properties.
4. Optional: Click Configure to configure additional properties. Select one endpoint from the displayed list of application names together with endpoint names that are imported into the repository. Click OK. The tuple definition of...
the endpoint is loaded into the list of columns on the output link and the columns currently defined for the link are deleted and replaced by the columns defined by the tuple definition.

5. Specify required details in the Properties tab, the Columns tab, the Advanced tab, and the Partitioning tab.

6. Click OK to save the settings.

Setting up column definitions (InfoSphere Streams connector)
You can set up column definitions for a link and also customize the columns grid, save column definitions, and load predefined column definitions from the repository.

Procedure
1. On the job design canvas, double-click the Streams Connector icon.
2. Select the Input link tab.
3. On the Columns tab, modify the columns grid to specify the metadata that you want to define.
   a. Right-click within the grid, and select Properties from the menu.
   b. In the Grid properties window, select the properties that you want to display and the order that you want them to be displayed. Then, click OK.
4. Enter column definitions for the table by using one of the following methods:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Method 1: Work in column grid directly      | 1. In the Column name column, double-click inside the appropriate cell and type a column name.  
   2. For each cell in the row, double-click inside the cell and select the options that you want.  
   3. In the Description column, double-click inside the appropriate cell and type a description. |
| Method 2: Work in a separate window         | 1. Right-click within the grid, and select Edit row from the menu.  
   2. In the Edit column metadata window, enter the column metadata. |

5. To share metadata between several columns, right-click the column and select Propagate values. In the Propagate column values window, select the properties that you want the selected columns to share and click OK.

6. To save the column definitions as a table definition in the repository, click Save and specify the name and location for the table definition.

7. To load column definitions from the repository, click Load and select the table definition and columns that you want to load.

Defining properties for sending data (InfoSphere Streams connector)
You must configure how the InfoSphere Streams connector operates in a job when sending data.

Before you begin
You must configure a connection (as a target) for the InfoSphere Streams connector.
**Procedure**

1. On the job design canvas, double-click the Streams Connector icon.
2. Click the Properties tab.
3. On the Properties tab define the properties in the Usage section to specify how the connector operates in a job.
4. Click OK.

**Runtime column validations (InfoSphere Streams connector)**

You can validate extra columns when the InfoSphere Streams connector is used as a source or as a target using the Schema reconciliation property.

**Validating extra columns when used as a source stage**

- If there are any additional columns on the link that do not map to attributes of the tuple, the connector might issue a warning at initialization time that link has unmatched columns, or it might fail the job. The property Usage > Schema reconciliation > Unmatched columns determines whether this condition is ignored, or results in a warning or job failure. The connector drops any unmatched column from the schema.
- If there are attributes in the tuple that do not match to columns, the connector might issue a warning message at initialization time that the attributes are ignored, or it might fail the job. The property Usage > Schema reconciliation > Unmatched attributes determines whether this condition is ignored, or results in a warning or job failure. This feature allows a user to ignore tuple attributes that are not of interest by excluding them from the design schema, and hence to improve the performance of the job.
- If there are attributes in the tuple that do not match to columns, the connector does not issue a warning message at initialization time and all attributes of the tuple are sent to the output link.

**Validating extra columns when used as a target stage**

- If there are additional columns on the link that do not map to attributes of the tuple, the connector might generate a warning at initialization time that the link has extra columns, or it might fail the job. The property Usage > Schema reconciliation > Unmatched columns determines whether this condition is ignored, or results in a warning or job failure.
- If there are attributes in the tuple that do not match to columns, the connector might issue a warning message at initialization time that there are unmatched attributes, or it might fail the job. The property Usage > Schema reconciliation > Unmatched attributes determines whether this condition is ignored, or results in a warning or job failure.

**Data type conversions (InfoSphere Streams connector)**

IBM® InfoSphere DataStage supports a set of data types that are different from InfoSphere Streams data types.

The InfoSphere Streams connector supports the following:

- Data type mapping during Streams Processing Language (SPL) code generation by the Streams Processing Language (SPL) Code generator (in InfoSphere Streams) process from the InfoSphere DataStage jobs that contain the InfoSphere Streams connector.
- Data type mapping when importing the InfoSphere Streams metadata by using the InfoSphere Streams Metadata Bridge in InfoSphere Metadata Asset Manager.
Data type conversions from InfoSphere DataStage to InfoSphere Streams

The following table defines data type mapping during SPL code generation by the SPL Code generator (in InfoSphere Streams) that processes the data streams from the InfoSphere DataStage jobs that contain the InfoSphere Streams connector.

Table 1. InfoSphere DataStage data types and their equivalent InfoSphere Streams data types

<table>
<thead>
<tr>
<th>InfoSphere DataStage data types</th>
<th>InfoSphere Streams data types</th>
</tr>
</thead>
<tbody>
<tr>
<td>TinyInt</td>
<td>int8</td>
</tr>
<tr>
<td>TinyInt (Unsigned)</td>
<td>uint8</td>
</tr>
<tr>
<td>SmallInt</td>
<td>int16</td>
</tr>
<tr>
<td>SmallInt (Unsigned)</td>
<td>uint16</td>
</tr>
<tr>
<td>Integer</td>
<td>int32</td>
</tr>
<tr>
<td>Integer (Unsigned)</td>
<td>uint32</td>
</tr>
<tr>
<td>BigInt</td>
<td>int64</td>
</tr>
<tr>
<td>BigInt (Unsigned)</td>
<td>uint64</td>
</tr>
<tr>
<td>Float, Real</td>
<td>float32</td>
</tr>
<tr>
<td>Double</td>
<td>float64</td>
</tr>
<tr>
<td>Decimal, Numeric</td>
<td>decimal32, decimal64, decimal128</td>
</tr>
</tbody>
</table>
| Note: Streams SPL Code generator will map DataStage decimal and numeric data types into Streams data types depending on the defined decimal number precision of data stage data types:  
  • precision <= 7 -> decimal32  
  • 7 < precision <= 16 -> decimal64  
  • precision > 16 -> decimal128  
  if precision is not specified, default is decimal64. |
| Unknown, Char, VarChar, LongVarChar | rstring, rstring[n] | Note: If the DataStage type has a maximum length specified, then the type will be mapped to rstring[n], otherwise it will be mapped to rstring. |
| NChar, NVarChar, LongNVarChar    | ustring                      |
| Binary, VarBinary, LongVarBinary| blob                         |
| Bit                             | boolean                      |
| Time                            | timestamp. The date component of the timestamp is set to 1970-01-01 (the Epoch date). |
| Date                            | timestamp. The time component of the timestamp is set to 0. |
| Timestamp                       | timestamp                    |
Data type conversions from InfoSphere Streams to InfoSphere DataStage

The following table defines data type mapping when importing the InfoSphere Streams metadata by using the InfoSphere Streams Metadata Bridge in InfoSphere Metadata Asset Manager.

*Table 2. InfoSphere Streams data types and their equivalent InfoSphere DataStage data types*

<table>
<thead>
<tr>
<th>InfoSphere Streams data types</th>
<th>InfoSphere DataStage data types</th>
</tr>
</thead>
<tbody>
<tr>
<td>boolean</td>
<td>Bit (0 or 1)</td>
</tr>
<tr>
<td>int8</td>
<td>TinyInt</td>
</tr>
<tr>
<td>uint8</td>
<td>TinyInt (Unsigned)</td>
</tr>
<tr>
<td>int16</td>
<td>SmallInt</td>
</tr>
<tr>
<td>uint16</td>
<td>SmallInt (Unsigned)</td>
</tr>
<tr>
<td>int32</td>
<td>Int</td>
</tr>
<tr>
<td>uint32</td>
<td>Int (Unsigned)</td>
</tr>
<tr>
<td>int64</td>
<td>BigInt</td>
</tr>
<tr>
<td>uint64</td>
<td>BigInt (Unsigned)</td>
</tr>
<tr>
<td>float32</td>
<td>Float</td>
</tr>
<tr>
<td>float64</td>
<td>Double</td>
</tr>
<tr>
<td>decimal32</td>
<td>VarChar or Decimal/Numeric</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> There is no DataStage equivalent type to the streams floating decimals, the safest type that preserves precision is character representation of floating decimals, the character format of the number is in the normalized scientific presentation.</td>
</tr>
<tr>
<td>decimal64</td>
<td>VarChar</td>
</tr>
<tr>
<td>decimal128</td>
<td>VarChar</td>
</tr>
<tr>
<td>complex32</td>
<td>2 Float columns: real followed by imaginary parts.</td>
</tr>
<tr>
<td>complex64</td>
<td>2 Double columns: real followed by imaginary parts.</td>
</tr>
<tr>
<td>rstring</td>
<td>VarChar</td>
</tr>
<tr>
<td>ustring</td>
<td>NVarChar</td>
</tr>
<tr>
<td>XML</td>
<td>LongVarBinary</td>
</tr>
<tr>
<td>timestamp</td>
<td>Timestamp (potential loss of precision)</td>
</tr>
<tr>
<td>blob</td>
<td>LongVarBinary</td>
</tr>
<tr>
<td>enum</td>
<td>Integer. The value is the integral enumerated code value defined by the Streams type.</td>
</tr>
<tr>
<td>tuple</td>
<td>Tuples are supported, but the hierarchy is flattened in the link metadata. See note at the end of the table for more information.</td>
</tr>
</tbody>
</table>
Table 2. InfoSphere Streams data types and their equivalent InfoSphere DataStage data types (continued)

<table>
<thead>
<tr>
<th>InfoSphere Streams data types</th>
<th>InfoSphere DataStage data types</th>
</tr>
</thead>
<tbody>
<tr>
<td>collections</td>
<td>VarChar, (if the Streams collection type has no elements of type ustring, the Streams collection type is mapped to DataStage varchar type), NVarChar, (if the Streams collection type has at least one element of type ustring, the Streams collection type is mapped to NVarChar DataStage type).</td>
</tr>
</tbody>
</table>

**Note:** The import of InfoSphere Streams metadata into InfoSphere Metadata Asset Manager has no limitations. All tuples, nested tuples, collections, enums and primitive types can be imported. Specific limitations are:

**Nested tuples**
Data types `tuple<int32 id, tuple<float64 long, float64 lat> location, rstring name>` is supported because the data is effectively flat. The metadata is represented on the link as 4 columns: id, long, lat & name. The name of the tuple attribute, location, is not included in the column name, but the description of the field needs to be set to include the path of the field (for example: “location.long”, “location.lat”).

**Collections**
The InfoSphere Streams connector supports all Streams collection types: list, set and map, by flattening them to an XML string. The connector supports sending and receiving of collection types, and supports bounded and unbounded collections. The column carrying the XML can be any string type including native and Unicode strings. The InfoSphere Streams connector supports only collections of primitive types, collections of nested collections is not supported.

The following XSD describes the XML format used to pass the collection data.

```xml
<?xml version="1.0" encoding="UTF-8"?>
<xs:schema xmlns:ccstreams="http://com.ibm.iis.streams"
xmlns:xs="http://www.w3.org/2001/XMLSchema"
attributeFormDefault="unqualified"
elementFormDefault="unqualified"
ccstreams:hdiSchemaVersion="1.0"
targetNamespace="http://com.ibm.iis.streams">
  <xs:element name="List" type="ccstreams:ListOrSetCollection"/>
  <xs:element name="Set" type="ccstreams:ListOrSetCollection"/>
  <xs:element name="Map" type="ccstreams:MapCollection"/>
  <xs:complexType name="ListOrSetCollection">
    <xs:sequence minOccurs="0" maxOccurs="unbounded">
      <xs:element name="V" type="xs:string"/>
    </xs:sequence>
  </xs:complexType>
  <xs:complexType name="MapCollection">
    <xs:sequence minOccurs="0" maxOccurs="unbounded">
      <xs:element name="E" type="ccstreams:MapEntry"/>
    </xs:sequence>
  </xs:complexType>
  <xs:complexType name="MapEntry">
    <xs:sequence minOccurs="0" maxOccurs="1">
      <xs:element name="K" type="xs:string"/>
    </xs:sequence>
  </xs:complexType>
</xs:schema>
```
An example of the XML for a list <rstring> containing 3 elements is as follows:

<?xml version="1.0" ?>
<cs:List xmlns:cs="http://com.ibm.iis.streams">
  <V>Cat</V>
  <V>Dog</V>
  <V>Mouse</V>
</cs:List>

An example of the XML for a map <int32, rstring> containing 3 elements is as follows:

<?xml version="1.0" ?>
<cs:Map xmlns:cs="http://com.ibm.iis.streams">
  <E><K>100</K><V>Badger</V><E>
  <E><K>200</K><V>Skunk</V><E>
  <E><K>300</K><V>Hamster</V><E>
</cs:Map>

E is an abbreviation for ‘entry’, K is an abbreviation for ‘key’ and V is an abbreviation for ‘value’. These short names are used to minimize the length of the XML string. XML is used since it can be readily built and parsed by the XML stage.

All element values are represented as a string within the XML. The expected format is as mentioned in the following table:

<table>
<thead>
<tr>
<th>Type</th>
<th>Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>decimal</td>
<td>A decimal string, e.g. “123.456”, “1.23e+10”.</td>
</tr>
<tr>
<td>timestamp</td>
<td>“YYYY-MM-DD MI:SS:YY[.FFFFFFFF]”</td>
</tr>
<tr>
<td>complex</td>
<td>Two decimal strings separated by a comma. The decimal strings may optionally be in scientific notation, e.g. “123.4,874.2” or “1.23e5,4.56e-19”.</td>
</tr>
<tr>
<td>blob</td>
<td>A hexadecimal string, e.g. “04F2B05005” represents the decimal byte values 4, 242, 176, 80, 5.</td>
</tr>
</tbody>
</table>

**Bounded collections**

When passing a bounded collection from InfoSphere DataStage to InfoSphere Streams, the XML data that is sent must include values for all elements of the collection including the unused elements of the collection. if the number of elements passed in the XML string is less than the bounded size, then Null values as defined by the connector properties Usage > Null values are sent for the unused elements of the collection.

**Compiling and running InfoSphere Streams connector jobs**

You can compile InfoSphere Streams connector jobs into executable scripts that you can schedule and run.

**Procedure**

1. In the InfoSphere DataStage and QualityStage Designer client, open the job that you want to compile.
2. Click Compile.
3. If the Compilation Status area shows errors, edit the job to resolve the errors. After resolving the errors, click **Re-compile**.

4. When the job compiles successfully, click **Run**, and specify the job run options:
   a. Enter the job parameters as required.
   b. Click **Validate** to verify that the job will run successfully without actually extracting, converting, or writing data.
   c. Click **Run** to extract, convert, or write data.

5. To view the results of validating or running a job:
   a. In the Designer client, select **Tools > Run Director** to open the Director client.
   b. In the Status column, verify that the job was validated or completed successfully.
   c. If the job or validation fails, select **View > Log** to identify any runtime problems.

6. If the job has runtime problems, fix the problems, recompile, validate (optional), and run the job until it completes successfully.

---

**Troubleshooting (InfoSphere Streams connector)**

When using the InfoSphere Streams connector, you might encounter errors that can be fixed by troubleshooting, adjusting values for properties or configuration. The most common types of errors that you might encounter are Name Server Authorization errors, runtime errors, and GUI errors.

**Name Server Authorization errors**

If there are problems with the HTTPS communication when accessing the InfoSphere SWS Streams name server service, you might encounter any one of the following authorization errors:
Table 3. Authorization errors

<table>
<thead>
<tr>
<th>Error details</th>
<th>Troubleshooting details</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Invalid keystore file:</strong> Streams Stage 0,0:</td>
<td>If the errors occur when testing the connection by using the test link in the InfoSphere Streams connector stage user interface, to correct the error, verify, and configure the name server authentication and client authentication as required.</td>
</tr>
<tr>
<td>Failed to lookup the name from the name server:</td>
<td></td>
</tr>
<tr>
<td>java.lang.Exception:</td>
<td></td>
</tr>
<tr>
<td>Truststore file does not exist: C:\KeyStore\badname.jks</td>
<td></td>
</tr>
<tr>
<td><strong>Invalid client certificate file:</strong> Streams Stage 0,0:</td>
<td>If the error persists, verify that the ASB agent is working and if required restart the ASB agent on your server that hosts the Information Server engine tier.</td>
</tr>
<tr>
<td>Failed to lookup the name from the name server:</td>
<td></td>
</tr>
<tr>
<td>java.security.KeyStoreException: IBMKeyManager:</td>
<td></td>
</tr>
<tr>
<td>Problem accessing key store:</td>
<td></td>
</tr>
<tr>
<td>java.lang.Exception:</td>
<td></td>
</tr>
<tr>
<td>Keystore file does not exist: bad.p12</td>
<td></td>
</tr>
<tr>
<td><strong>Invalid client certificate password:</strong> Streams Stage 0,0:</td>
<td>Note: For details about the InfoSphere Streams SWS security settings, see the InfoSphere Streams Installation and Administration Guide.</td>
</tr>
<tr>
<td>Failed to lookup the name from the name server:</td>
<td></td>
</tr>
<tr>
<td>java.security.KeyStoreException: IBMKeyManager:</td>
<td></td>
</tr>
<tr>
<td>Problem accessing key store:</td>
<td></td>
</tr>
<tr>
<td>java.io.IOException:</td>
<td></td>
</tr>
<tr>
<td>Unable to verify MAC.</td>
<td></td>
</tr>
<tr>
<td>Client authentication is enabled in the Streams Name Server but not configured in the Streams Connector:</td>
<td></td>
</tr>
<tr>
<td>Streams Stage 0,0:</td>
<td></td>
</tr>
<tr>
<td>Failed to lookup the name from the name server:</td>
<td></td>
</tr>
<tr>
<td>Software caused connection abort: socket write error</td>
<td></td>
</tr>
<tr>
<td>Server certificate is updated on the Streams server, but the client keystore is out of date with respect to the server certificate:</td>
<td></td>
</tr>
<tr>
<td>Streams Stage 0,0:</td>
<td></td>
</tr>
<tr>
<td>Failed to lookup the name from the name server:</td>
<td></td>
</tr>
<tr>
<td>com.ibm.jsse2.util.g:</td>
<td></td>
</tr>
<tr>
<td>PKIX path building failed:</td>
<td></td>
</tr>
<tr>
<td>java.security.cert.</td>
<td></td>
</tr>
<tr>
<td>CertPathBuilderException:</td>
<td></td>
</tr>
<tr>
<td>unable to find valid certification path to requested target</td>
<td></td>
</tr>
</tbody>
</table>
Runtime errors

You might encounter the following error when running an InfoSphere Streams job:

Table 4. Runtime errors

<table>
<thead>
<tr>
<th>Error details</th>
<th>Troubleshooting details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Streams_Side_5, 0: End point name &lt;endpoint name&gt; was not found.</td>
<td>This error occurs when the InfoSphere Streams application that contains the specific endpoint is not registered with the InfoSphere Streams Name Server, either because the InfoSphere Streams application is not running, or because it is in invalid state. To check the status of the InfoSphere Streams job, log in to the InfoSphere Streams server, run the streams toolkit command <code>lsjobs</code>, and then verify the <code>Healthy</code> status of the listed job, for example: $ streamtool lsjobs -i <code>&lt;My Streams Instance name&gt;</code> Instance: <code>&lt;My Streams instance name&gt;</code> Id State <code>Healthy</code> User 2 Running no dsadm Date 2012-06-19T00:44:53+0530 Name <code>&lt;My Streams job name&gt;</code></td>
</tr>
<tr>
<td>Streams_Connector_4,0: java.lang.Exception: Login to host <a href="">hostname:port_number</a> with user &lt;user name&gt; failed.</td>
<td>This error occurs when the LDAP password of InfoSphere Streams server user account is changed. To correct this error, you need to re-create the InfoSphere Streams instance and update the InfoSphere Streams name server password in DataStage jobs. <strong>Note:</strong> For more information about the Streams concepts, see the InfoSphere Streams documentation.</td>
</tr>
</tbody>
</table>

GUI errors

When you click **Configure** on the InfoSphere Streams connector stage user interface to select an endpoint, either the user interface might hang, or nothing happens, or you might encounter the following error:

Table 5. GUI errors

<table>
<thead>
<tr>
<th>Error details</th>
<th>Troubleshooting details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Failed to instantiate the resource wrapper class.</td>
<td>This error occurs because of a problem in communication between the InfoSphere Streams connector stage user interface and the ASB agent. To correct the error, you need to restart the ASB agent service on your server that hosts the Information Server engine tier, and try again to select the endpoint.</td>
</tr>
</tbody>
</table>
Appendix A. Product accessibility

You can get information about the accessibility status of IBM products.

The IBM InfoSphere Information Server product modules and user interfaces are not fully accessible. The installation program installs the following product modules and components:
- IBM InfoSphere Business Glossary
- IBM InfoSphere Business Glossary Anywhere
- IBM InfoSphere DataStage
- IBM InfoSphere FastTrack
- IBM InfoSphere Information Analyzer
- IBM InfoSphere Information Services Director
- IBM InfoSphere Metadata Workbench
- IBM InfoSphere QualityStage

For information about the accessibility status of IBM products, see the IBM product accessibility information at http://www.ibm.com/able/product_accessibility/index.html.

Accessible documentation

Accessible documentation for InfoSphere Information Server products is provided in an information center. The information center presents the documentation in XHTML 1.0 format, which is viewable in most Web browsers. XHTML allows you to set display preferences in your browser. It also allows you to use screen readers and other assistive technologies to access the documentation.

The documentation that is in the information center is also provided in PDF files, which are not fully accessible.

IBM and accessibility

See the IBM Human Ability and Accessibility Center for more information about the commitment that IBM has to accessibility.
Appendix B. Reading command-line syntax

This documentation uses special characters to define the command-line syntax.

The following special characters define the command-line syntax:

[] Identifies an optional argument. Arguments that are not enclosed in
brackets are required.

... Indicates that you can specify multiple values for the previous argument.

| Indicates mutually exclusive information. You can use the argument to the
left of the separator or the argument to the right of the separator. You
cannot use both arguments in a single use of the command.

{} Delimits a set of mutually exclusive arguments when one of the arguments
is required. If the arguments are optional, they are enclosed in brackets ([
]).

Note:
• The maximum number of characters in an argument is 256.
• Enclose argument values that have embedded spaces with either single or
double quotation marks.

For example:

**wsetsrc** [-S server] [-l label] [-n name] source

The *source* argument is the only required argument for the *wsetsrc* command. The
brackets around the other arguments indicate that these arguments are optional.

**wlsac** [-l | -f format] [key... ] profile

In this example, the -l and -f format arguments are mutually exclusive and
optional. The *profile* argument is required. The *key* argument is optional. The
ellipsis (...) that follows the *key* argument indicates that you can specify multiple
key names.

**wrb** -import {rule_pack | rule_set}...

In this example, the *rule_pack* and *rule_set* arguments are mutually exclusive, but
one of the arguments must be specified. Also, the ellipses marks (...) indicate that
you can specify multiple rule packs or rule sets.
Appendix C. How to read syntax diagrams

The following rules apply to the syntax diagrams that are used in this information:

- Read the syntax diagrams from left to right, from top to bottom, following the path of the line. The following conventions are used:
  - The >>> symbol indicates the beginning of a syntax diagram.
  - The ---> symbol indicates that the syntax diagram is continued on the next line.
  - The >--- symbol indicates that a syntax diagram is continued from the previous line.
  - The -->< symbol indicates the end of a syntax diagram.
- Required items appear on the horizontal line (the main path).

- Optional items appear below the main path.

If an optional item appears above the main path, that item has no effect on the execution of the syntax element and is used only for readability.

- If you can choose from two or more items, they appear vertically, in a stack.

If you must choose one of the items, one item of the stack appears on the main path.

- If choosing one of the items is optional, the entire stack appears below the main path.

If one of the items is the default, it appears above the main path, and the remaining choices are shown below.

- An arrow returning to the left, above the main line, indicates an item that can be repeated.
If the repeat arrow contains a comma, you must separate repeated items with a comma.

A repeat arrow above a stack indicates that you can repeat the items in the stack.

- Sometimes a diagram must be split into fragments. The syntax fragment is shown separately from the main syntax diagram, but the contents of the fragment should be read as if they are on the main path of the diagram.

Fragment-name:

- Keywords, and their minimum abbreviations if applicable, appear in uppercase. They must be spelled exactly as shown.
- Variables appear in all lowercase italic letters (for example, column-name). They represent user-supplied names or values.
- Separate keywords and parameters by at least one space if no intervening punctuation is shown in the diagram.
- Enter punctuation marks, parentheses, arithmetic operators, and other symbols, exactly as shown in the diagram.
- Footnotes are shown by a number in parentheses, for example (1).
Appendix D. Contacting IBM

You can contact IBM for customer support, software services, product information, and general information. You also can provide feedback to IBM about products and documentation.

The following table lists resources for customer support, software services, training, and product and solutions information.

Table 6. IBM resources

<table>
<thead>
<tr>
<th>Resource</th>
<th>Description and location</th>
</tr>
</thead>
<tbody>
<tr>
<td>IBM Support Portal</td>
<td>You can customize support information by choosing the products and the topics that interest you at [<a href="http://www.ibm.com/support/entry/portal/Software/Information_Management/InfoSphere">www.ibm.com/support/entry/portal/Software/Information_Management/InfoSphere</a> Information Server](<a href="http://www.ibm.com/support/entry/portal/Software/Information_Management/InfoSphere">http://www.ibm.com/support/entry/portal/Software/Information_Management/InfoSphere</a> Information Server)</td>
</tr>
<tr>
<td>Software services</td>
<td>You can find information about software, IT, and business consulting services, on the solutions site at <a href="http://www.ibm.com/businesssolutions/">www.ibm.com/businesssolutions/</a></td>
</tr>
<tr>
<td>My IBM</td>
<td>You can manage links to IBM Web sites and information that meet your specific technical support needs by creating an account on the My IBM site at <a href="http://www.ibm.com/account/">www.ibm.com/account/</a></td>
</tr>
<tr>
<td>Training and certification</td>
<td>You can learn about technical training and education services designed for individuals, companies, and public organizations to acquire, maintain, and optimize their IT skills at <a href="http://www.ibm.com/software/sw-training/">http://www.ibm.com/software/sw-training/</a></td>
</tr>
</tbody>
</table>
Appendix E. Accessing and providing feedback on the product documentation

Documentation is provided in a variety of locations and formats, including in help that is opened directly from the product client interfaces, in a suite-wide information center, and in PDF file books.

The information center is installed as a common service with IBM InfoSphere Information Server. The information center contains help for most of the product interfaces, as well as complete documentation for all the product modules in the suite. You can open the information center from the installed product or from a Web browser.

Accessing the information center

You can use the following methods to open the installed information center.

- Click the Help link in the upper right of the client interface.

  **Note:** From IBM InfoSphere FastTrack and IBM InfoSphere Information Server Manager, the main Help item opens a local help system. Choose Help > Open Info Center to open the full suite information center.

- Press the F1 key. The F1 key typically opens the topic that describes the current context of the client interface.

  **Note:** The F1 key does not work in Web clients.

- Use a Web browser to access the installed information center even when you are not logged in to the product. Enter the following address in a Web browser: http://host_name:port_number/infocenter/topic/com.ibm.swg.im.iis.productization.iisinfsv.home.doc/ic-homepage.html. The host_name is the name of the services tier computer where the information center is installed, and port_number is the port number for InfoSphere Information Server. The default port number is 9080. For example, on a Microsoft® Windows® Server computer named iisdocs2, the Web address is in the following format: http://iisdocs2:9080/infocenter/topic/com.ibm.swg.im.iis.productization.iisinfsv.nav.doc/dochome/iisinfsrv_home.html.

A subset of the information center is also available on the IBM Web site and periodically refreshed at http://publib.boulder.ibm.com/infocenter/iisinfsv/v8r7/index.jsp.

Obtaining PDF and hardcopy documentation

- A subset of the PDF file books are available through the InfoSphere Information Server software installer and the distribution media. The other PDF file books are available online and can be accessed from this support document: https://www.ibm.com/support/docview.wss?uid=swg27008803&wv=1

- You can also order IBM publications in hardcopy format online or through your local IBM representative. To order publications online, go to the IBM Publications Center at http://www.ibm.com/e-business/linkweb/publications/servlet/pbi.wss
Providing comments on the documentation

Your feedback helps IBM to provide quality information. You can use any of the following methods to provide comments:

- To comment on the information center, click the Feedback link on the top right side of any topic in the information center.
- Send your comments by using the online readers’ comment form at www.ibm.com/software/awdtools/rcf/.
- Send your comments by e-mail to comments@us.ibm.com. Include the name of the product, the version number of the product, and the name and part number of the information (if applicable). If you are commenting on specific text, include the location of the text (for example, a title, a table number, or a page number).
- You can provide general product feedback through the Consumability Survey at www.ibm.com/software/data/info/consumability-survey.
Notices and trademarks

This information was developed for products and services offered in the U.S.A.

Notices

IBM may not offer the products, services, or features discussed in this document in other countries. Consult your local IBM representative for information on the products and services currently available in your area. Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM product, program, or service may be used. Any functionally equivalent product, program, or service that does not infringe any IBM intellectual property right may be used instead. However, it is the user's responsibility to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this document. The furnishing of this document does not grant you any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785 U.S.A.

For license inquiries regarding double-byte character set (DBCS) information, contact the IBM Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.
1623-14, Shimotsuruma, Yamato-shi
Kanagawa 242-8502 Japan

The following paragraph does not apply to the United Kingdom or any other country where such provisions are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made to the information herein; these changes will be incorporated in new editions of the publication. IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the exchange of information between independently created programs and other programs (including this one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Corporation
J46A/G4
555 Bailey Avenue
San Jose, CA 95141-1003 U.S.A.

Such information may be available, subject to appropriate terms and conditions, including in some cases, payment of a fee.

The licensed program described in this document and all licensed material available for it are provided by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the results obtained in other operating environments may vary significantly. Some measurements may have been made on development-level systems and there is no guarantee that these measurements will be the same on generally available systems. Furthermore, some measurements may have been estimated through extrapolation. Actual results may vary. Users of this document should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, their published announcements or other publicly available sources. IBM has not tested those products and cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of those products.

All statements regarding IBM’s future direction or intent are subject to change or withdrawal without notice, and represent goals and objectives only.

This information is for planning purposes only. The information herein is subject to change before the products described become available.

This information contains examples of data and reports used in daily business operations. To illustrate them as completely as possible, the examples include the names of individuals, companies, brands, and products. All of these names are fictitious and any similarity to the names and addresses used by an actual business enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrate programming techniques on various operating platforms. You may copy, modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application programs conforming to the application programming interface for the operating platform for which the sample programs are written. These examples have not been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these programs. The sample programs are provided "AS IS", without warranty of any kind. IBM shall not be liable for any damages arising out of your use of the sample programs.

Each copy or any portion of these sample programs or any derivative work, must include a copyright notice as follows:

© (your company name) (year). Portions of this code are derived from IBM Corp. Sample Programs. © Copyright IBM Corp. _enter the year or years_. All rights reserved.

If you are viewing this information softcopy, the photographs and color illustrations may not appear.

**Trademarks**

IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of International Business Machines Corp., registered in many jurisdictions worldwide. Other product and service names might be trademarks of IBM or other companies. A current list of IBM trademarks is available on the Web at [www.ibm.com/legal/copytrade.shtml](http://www.ibm.com/legal/copytrade.shtml).

The following terms are trademarks or registered trademarks of other companies:

Adobe is a registered trademark of Adobe Systems Incorporated in the United States, and/or other countries.

Intel and Itanium are trademarks or registered trademarks of Intel Corporation or its subsidiaries in the United States and other countries.

Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both.

Microsoft, Windows and Windows NT are trademarks of Microsoft Corporation in the United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other countries.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Oracle and/or its affiliates.

The United States Postal Service owns the following trademarks: CASS, CASS Certified, DPV, LACS\textsuperscript{link}, ZIP, ZIP + 4, ZIP Code, Post Office, Postal Service, USPS and United States Postal Service. IBM Corporation is a non-exclusive DPV and LACS\textsuperscript{link} licensee of the United States Postal Service.

Other company, product or service names may be trademarks or service marks of others.